Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

| WARNING | indicates that death or severe personal injury may result if proper precautions are not taken. |
| CAUTION | indicates that minor personal injury can result if proper precautions are not taken. |
| NOTICE  | indicates that property damage can result if proper precautions are not taken. |

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

| WARNING | Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed. |

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Introduction........................................................................................................................................... 5  
   1.1 Purpose of this Documentation........................................................................................................ 5  
   1.2 Further information........................................................................................................................... 5  

2 General safety notes .............................................................................................................................. 7  
   2.1 General information .......................................................................................................................... 7  
   2.2 Correct usage...................................................................................................................................... 7  
   2.3 Laws and directives........................................................................................................................... 7  
   2.4 Qualified Personnel......................................................................................................................... 8  

3 Description........................................................................................................................................... 9  
   3.1 Applications...................................................................................................................................... 9  
   3.2 Product features ............................................................................................................................... 9  
   3.3 Scope of delivery.............................................................................................................................. 10  
      3.3.1 Modem with a USB connection (7NG3092-8KU)........................................................................ 10  
      3.3.2 Modem with a RS232 connection (7NG3092-8KM).................................................................... 10  

4 Installing ............................................................................................................................................. 11  
   4.1 Hardware and software requirements............................................................................................ 11  
   4.2 Installing the SIPROM T parameterization software...................................................................... 11  
   4.3 Installing the USB driver ............................................................................................................... 12  
      4.3.1 Step 1: Preparing for installation................................................................................................. 12  
      4.3.2 Step 2: Installation of the USB modem ....................................................................................... 16  
      4.3.3 Step 3: Entries in the SIPROM T parameterization software...................................................... 21  
   4.4 Uninstalling the USB driver............................................................................................................. 23  

5 Commissioning .................................................................................................................................... 27  
   5.1 Safety notes for commissioning...................................................................................................... 27  
   5.2 Commissioning the modem .......................................................................................................... 28  
   5.3 Meaning of LEDs on the modem .................................................................................................. 30  

6 Operating SIPROM T .............................................................................................................................. 31  

7 Troubleshooting/Maintenance .............................................................................................................. 35  
   7.1 Troubleshooting .............................................................................................................................. 35  
   7.2 Maintenance ................................................................................................................................. 35  

8 Technical data ..................................................................................................................................... 37  

9 Certificates........................................................................................................................................... 39  

Index...................................................................................................................................................... 41
Introduction

1.1 Purpose of this Documentation

This programming manual contains all information you need for commissioning and using the modem and the SIPROM T parameterization software.

It is aimed both at persons mechanically installing the device, connecting it electronically, configuring the parameters and putting it into operation, and at service and maintenance engineers.

1.2 Further information

Information

The contents of these instructions shall not become part of or modify any prior or existing agreement, commitment or legal relationship. All obligations on the part of Siemens AG are contained in the respective sales contract, which also contains the complete and solely applicable warranty conditions. Any statements contained herein do not create new warranties or modify the existing warranty.

The content reflects the technical status at the time of printing. We reserve the right to make technical changes in the course of further development.

Siemens Regional Offices

If you need more information or have particular problems which are not covered sufficiently by the operating instructions, contact your local Siemens Regional Office. You will find the address of your local Siemens Regional Office on the Internet.

Product information on the Internet

The Programming Manual forms a part of the supplied CD and is also available on the Siemens homepage on the Internet. On the enclosed CD, you will find an extract of the catalog FI 01 "Field devices for process automation" with the current ordering data. The complete catalog FI 01 is available on the Internet.

See also

Siemens regional offices (https://www.siemens.com/processinstrumentation/contacts)

Product information on the Internet (https://www.siemens.com/sitrans)

Instructions and manuals (https://www.siemens.com/processinstrumentation/documentation)

Catalog FI 01 (https://www.siemens.com/fi01)
Introduction

1.2 Further information
General safety notes

2.1 General information

This device left the factory free from safety problems. In order to maintain this status and to ensure safe operation of the device, please observe the safety information and warnings contained in these instructions.

2.2 Correct usage

**WARNING**

Use and operation only in secure area under laboratory conditions

The SIPROM T modem can only be operated and configured together with the SITRANS TH100/TH200/TR200 temperature transmitters in a secure area and offline under laboratory conditions (pollution degree 1 or 2, max. $T_a \leq 30 \, ^\circ C$). Any 4 to 20 mA current loop connected to the transmitter must be disconnected completely before parameter assignment.

The device may only be used for the purposes specified in these instructions.

Insofar as they are not expressly stated in these instructions, all changes to the device are the sole responsibility of the user.

2.3 Laws and directives

The regulations of the test certification valid in your country are to be observed.

**WARNING**

This device may only be installed and operated once qualified personnel have ensured that appropriate power supplies are in use. These power supplies must guarantee that no hazardous voltage can reach the device, whether during normal operation or in the event of a malfunction of the system or one of its parts.
2.4 Qualified Personnel

"Qualified personnel" means those who are familiar with the installation, mounting, commissioning and operation of the product. They must have the following, appropriate qualifications for their activities:

- Training or instruction/authorization in operating and maintaining devices and systems according to the safety regulations for electrical circuits.
- For explosion-proof devices: Training or instruction/authorization in carrying out work on electrical circuits for hazardous systems.
- Training and instruction in maintenance and use of adequate safety equipment according to safety regulations.
- Should be trained in first aid.
3 Description

3.1 Applications

The modem for SITRANS TH100 and TH200 is used for the operation and parameterization of the transmitters SITRANS TH100 and SITRANS TH200 in the "Offline state". The modem is available in two different versions:

- Modem with a USB connection (order number 7NG3092-8KU)
- Modem with a RS232 connection (order number 7NG3092-8KM)

These operating instructions deal with the connection of the modem to the PC as well as to the transmitters SITRANS TH100 and SITRANS TH200.

Along with the modem, you will require the SIPROM T parameterization software for the operation and parameterization of the transmitters. The use of the SIPROM T parameterization software is also described.

**WARNING**

This modem should only be used for the parameterization of the transmitters SITRANS TH100 and TH200. Damage to the modem or the connected device is not ruled out otherwise.

3.2 Product features

- Universal modem for the parameterization of the transmitters SITRANS TH100 and TH200 in the Offline state using the SIPROM T parameterization software
- Available versions - modem version with:
  - USB connection (USB V1.1, compatible with USB 2.0) or
  - RS232 connection
- Electrical isolation between the PC and the transmitter to be parameterized
- Adherence to the EEx directive for the connected transmitter
- Feeding power to the USB modem (order number 7NG3092-8KU) using the power supply directly from the USB port of the PC.
- External power supply to the RS232 modem (order number 7NG3092-8KM) via the provided power adapter.
3.3 Scope of delivery

3.3.1 Modem with a USB connection (7NG3092-8KU)

The following is supplied with your modem for SITRANS TH100 and SITRANS TH200 with a USB connection:

- Warnings
- Product brief in German and English "USB-Modem - Installation Instructions (brief)"
- The "sitrans t - temperature transmitters" CD containing:
  - Operating instructions and approvals for all temperature measuring instruments
  - Operating instructions and approvals for the modem
  - SIPROM T parameterization software including the driver for the USB connection

This CD-ROM can also be ordered separately (order number A5E00364512).

- USB-“B”, USB-“A” cable, length 200 cm. The USB-“A” connector enables a connection with a PC or with a distribution hub compliant with the USB 1.1/USB 2.0 standard. We recommend using a four-wire hub with a built-in power supply.

3.3.2 Modem with a RS232 connection (7NG3092-8KM)

The following is supplied with your modem for SITRANS TH100 and TH200 with a RS232 connection:

- Warnings
- The "sitrans t - temperature transmitters" CD containing:
  - Operating instructions and approvals for all temperature measuring instruments
  - Operating instructions and approvals for the modem
  - SIPROM T parameterization software

This CD-ROM can also be ordered separately (order number A5E00364512).

- DC 6 V power adapter with a connecting cable; length 100 cm.
- RS232 cable for a connection with the PC-COM port; length 150 cm; the cable is permanently connected with the modem.
4. Installing

4.1 Hardware and software requirements

Software

You require a PC with one of the following operating systems for working with the modem for SITRANS TH100/TH200 as well as the corresponding SIPROM T parameterization software:

- Windows 95, 98, 98SE (only in combination with a RS232 modem 7NG3092-8KM)
- Windows ME, 2000
- Windows XP Professional
- Windows XP Home

Hardware

You require a PC with a CD-ROM drive and a USB port (for the USB modem) or a RS232 port (for the RS232 modem).

4.2 Installing the SIPROM T parameterization software

Introduction

The enclosed CD contains the SIPROM T parameterization software. You can also download the parameterization software from the Internet free of charge.

Procedure

Install the SIPROM T parameterization software as specified below:

1. Insert the enclosed CD "sitran s - temperature transmitters" into the CD-ROM drive of your PC.
   
   The Autostart function opens the main menu automatically. Alternatively, you can open the main menu by double clicking the "index.html" file.

2. Click on the desired language in the main menu.

3. Click "Software".
4. Click "SIPROM T". The SIPROM T parameterization software will be installed on your PC.

5. Follow the instructions and notes displayed during the installation process.

---

**Note**
The modem for SITRANS TH100/TH200 should be connected to the PC only after the installation of the parameterization software is complete.

---

**Result**
After successful installation, a new program group with the name "Siemens Process Instruments" is created in your Windows start menu. The USB driver that you require for the USB modem is also pre-installed.

**See also**
SIPROM T software package on the Internet
(http://www.siemens.com/processinstrumentation/downloads)

---

**4.3 Installing the USB driver**

**4.3.1 Step 1: Preparing for installation**

**Prerequisites**
- The SIPROM T parameterization software is installed, but not started as yet.
- You should be on the Windows desktop.
- All other processes should be closed as far as possible.
Procedure

Prepare for the installation of the USB modems as specified below:

1. Connect the USB modem to a free USB port of your computer using the cable provided. The 7NG3092-8KU modem is compatible with USB 1.x and USB 2.0. After plugging in, Windows opens the Hardware wizard automatically:

2. Click on the second installation option "Install from a list or specific location (Advanced)".

3. Confirm with "Next". The following window of the wizard appears:

4. Select the options "Search for the best driver in these locations" and "Include this location in the search".
4.3 Installing the USB driver

5. Click "Browse". The following window opens:

6. Select the directory in which the SIPROM T parameterization software and the USB drive were installed.

   The USB driver is installed in the 'C:\Program Files\SIPROM T\USB' sub-directory in case of a standard installation of the SIPROM T parameterization software.

   You must specify the appropriate path if you have installed the SIPROM T parameterization software in another directory.

7. Click "OK". You are now directed back to the previous window and the directory selected by you appears in the pull-down field.
8. Click "Next". The USB driver is being installed. The following window opens:

![Found New Hardware Wizard]

9. Click "Finish".

**Result**

This completes initial preparations for the installation of the USB driver. Now go to step 2 of the installation process.

**Note**

Only a part of the installation is carried out at this point in time. Do not abort the installation at this stage. Otherwise, the driver will not be installed correctly and the USB modem will not be detected by the SIPROM T parameterization software.

**See also**

Installing the SIPROM T parameterization software  (Page 11)
4.3.2  Step 2: Installation of the USB modem

Prerequisites

After executing step 1 of the installation, the Hardware wizard should open again automatically. The following window appears:

![Found New Hardware Wizard](image)

Procedure

Continue with the installation as specified below:

1. Click on the second installation option "Install from a list or specific location (Advanced)".
2. Confirm with "Next". The following window opens:
3. Check whether all settings that you have made in "Step 1: Preparing for installation" have been accepted. If not, you have to make these settings afresh as described in "Step 1: Preparing for installation".

4. Click "Next". The USB driver is being installed. The following window opens:

5. Click "Finish".

6. Check whether the system has set up the correct COM port for the SIPROM T parameterization software. For this purpose, invoke the "Control panel" via "Start -> Settings". The following window opens:
7. Double-click the "System" entry. The following window opens:

8. Click "Device Manager" in the "Hardware" tab. Windows calls up the Device Manager. The following window opens:
9. Double-click the "Ports (COM & LPT)" folder. All parallel (LPT) and serial ports (COM and USB) of your computer are displayed in this folder. The newly installed USB port has the name "USB Serial Port (COMx)", where x indicates the number of this COM port. It is COM3 in our example:

![Device Manager screenshot showing USB Serial Port (COM3)]

10. Note the number of the COM port; in our example, 3.

   If it is in the range from 1 to 8, you can continue the installation with "Step 3: Entries in the SIPROM T" parameterization software. Otherwise, the COM port number must be changed manually as described below.
11. If the COM port number is not in the range from 1 to 8, double-click the marked line in "Device Manager". The following window opens:

![USB Serial Port (COM3) Properties](image)

12. Click the "Port Settings" tab. The following window opens:

![USB Serial Port (COM3) Properties](image)
13. Click "Advanced..." The following window opens:

14. Select a matching port number in the "COM Port Number" field. COM numbers with the "in use" comment have already been occupied and can no longer be used.

If all COM ports are occupied, one serial port must be disabled to be able to install the USB driver. Please contact your system administrator in this case.

4.3.3 Step 3: Entries in the SIPROM T parameterization software

Prerequisites

- You should be on the Windows desktop.
- All other processes should be closed as far as possible.
4.3 Installing the USB driver

Procedure

The COM port number selected by you must be entered in the SIPROM T parameterization software. This is done as specified below:

1. Start the SIPROM T parameterization software via "Start -> Programs -> Siemens Process Instruments -> SIPROM T". The application is started and the following window opens:

![Image of SIPROM T parameterization software]

2. Select "Communication path" from the "Device" menu. The following window opens:
3. Select the COM port number that you have noted. This is the COM port that was displayed in "Device Manager". It was "COM3" (COM port 3) in our example.

4. Confirm the setting with "OK."

**Result**

The installation of the USB driver is completed successfully.

**See also**

Step 2: Installation of the USB modem (Page 16)

### 4.4 Uninstalling the USB driver

**Introduction**

You can uninstall the USB driver manually if you do not wish to continue using the SIPROM T parameterization software in combination with the USB modem.

**Note**

This action uninstalls only the USB driver and not the SIPROM T software. The SIPROM T software can be used with the RS232 modem after uninstalling the USB driver.
4.4 Uninstalling the USB driver

Procedure

Uninstall the USB driver as specified below:

1. Go to "C:\Program Files\SIPROM T\USB" in Windows Explorer if you have selected standard installation. If not, go to the directory in Windows Explorer where you have installed the USB driver:

2. Disconnect the USB modem from the USB connection of your PC.
3. Double-click "FTDIUNIN.EXE". The following window opens:

![FTDI Uninstaller Version 2.1 window]

4. Click "Continue." The following window opens:

![FTDI Uninstaller Version 2.1 window]

5. Click "Finish".

**Result**

The USB driver is uninstalled. SIPROM T can no longer be operated with the USB modem. The USB driver files however remain on your hard disk. If you wish to use the USB modem again, execute the installation process as described in "Step 2: Installation of the USB driver".

**See also**

Step 2: Installation of the USB modem (Page 16)
4.4 Uninstalling the USB driver
Commissioning

5

5.1 Safety notes for commissioning

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must only use the 6 V power adapter provided with the device for supplying power to the RS232 modem.</td>
</tr>
<tr>
<td>Connect the modem only to the prescribed transmitter SITRANS TH100/TH200. Only use the connecting cable provided with the modem for connecting the modem to the PC.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not exceed the permitted ambient conditions</td>
</tr>
<tr>
<td>Do not expose the modem to moisture or direct sunlight. Its use is restricted to laboratory conditions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure intrinsic safety of SITRANS TH100/TH200/TR200 temperature transmitters</td>
</tr>
<tr>
<td>If the red LED on the SIPROM T modem is lit, you must check that the modem is functioning correctly and the SITRANS TH100/TH200/TR200 temperature transmitter can no longer be used in hazardous areas.</td>
</tr>
</tbody>
</table>

Note
Parameters may only be assigned to SITRANS TH100/TH200 in the Offline state using the modem for SITRANS TH100/TH200 and the SIPROM T parameter assignment software. Any 4 to 20 mA current loop connected to the transmitter must be disconnected completely before parameter assignment.

Note
The SIPROM T parameter assignment software must be installed on your PC before you connect the USB modem to the USB port of your PC for the first time.

Note
DisConnecting the modem
Do not disconnect the transmitter from the modem during parameter assignment. After completing the parameter assignment process, wait for two seconds before disconnecting the transmitter. Non-observance may damage the device.
5.2 Commissioning the modem

Note
If you are using the USB modem for the parameter assignment of SITRANS TH100/TH200, do not disconnect the USB connector from the PC or the modem during the parameter assignment process.

Note
RF interference
The MODEM is a class A device. This device may emit RF interference in residential areas. In this case, you need to take appropriate measures.

Note
Interference emission of RF transmitters
The parameter assignment is intended only for use in a controlled electromagnetic environment. RF transmitters such as mobile phones may not be used in the immediate range.

5.2 Commissioning the modem

Note
The input variable is digitally requested and displayed by the PC during the parameterization process. The analog output current always remains constant.

You can use the SIPROM T parameterization software and the modem for SITRANS TH100/TH200 for changing the configuration of the transmitter via your PC. For this purpose, simply connect the transmitter to the PC via the modem. The power required by the transmitter is provided by:

- the USB port of the PC (in case of the USB modem)
- an external power adapter (in case of the RS232 modem)

Refer to figures "Parameterization via the USB modem" and "Parameterization via the RS232 modem".
5.2 Commissioning the modem

Parameterization via the USB modem

Parameterization via the RS232 modem

Note
USB modem versions: Insert the USB "B" connector into the jack, labelled "USB", on your modem. Connect the USB "A" connector to a free USB port of your PC.
5.3 Meaning of LEDs on the modem

LEDs on the modems for the SITRANS TH100/TH200 parameterization software have the following meaning:

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| Power | Green | Continuous  
For the USB modem: Illuminates when the modem is connected to the USB port of the PC and the operating system of your PC is in the normal mode. This LED switches off if the PC is in the standby or idle mode. 
For the RS232 modem: Illuminates when the supply voltage of the modem is switched on using the 6-V power adapter that is provided. |
| Comm  | Yellow| The LED flickers while transferring data from the PC to the modem. |
| Error | Red   | Illuminates continuously in case of internal errors in the modem (RAM errors) or if a short circuit is detected at the modem terminals for the transmitter during parameter input. |
Operating SIPROM T

Introduction

This section describes the most important menu items in brief. Please refer to the online help of the SIPROM T parameterization software regarding further notes for operating this software.

You will find the technical details regarding the sensor characteristics of SITRANS TH100 and SITRANS TH200 in the corresponding operating instructions. You will find these operating instructions on the enclosed CD and on the Internet.
Procedure

Start the SIPROM T programming software via "Start -> Programs -> Siemens Process Instruments -> SIPROM T". The splash screen of SIPROM T appears while the application is starting. The following window opens as soon as the application is loaded:

**Extras -> Settings -> Device**

Select whether you wish to assign parameters to SITRANS TH100 or SITRANS TH200.

**Extras -> Settings -> Communication path**

Determine the USB or COM port that SIPROM T should use for communicating with the modem.
Extras -> Settings -> Language

Select the language that SIPROM T should use to communicate with you.

Devices -> Load in the device

This menu is used for transferring the current table data from SIPROM T to SITRANS TH100 or SITRANS TH200.

Devices -> Load in the PC

This menu is used for transferring the current device parameters of the connected SITRANS TH100 or SITRANS TH200 to SIPROM T.

Note
The current table data is overwritten.

View -> Measuring value display

This menu is used for displaying the current digital value of the connected sensor. Although the current value associated with the digital value is displayed, the connected transmitter does not give a physical output.

File -> Save as ...

This menu is used for saving the current table data in a file. If additional transmitters are installed using the same parameter data, the saved data block can be used for copying the parameter data.

File > Open ...

This menu is used for loading a saved data block in SIPROM T. When delivered, SIPROM T contains one standard data block each for SITRANS TH100 and SITRANS TH200.
7.1 Troubleshooting

Explanations for troubleshooting minor faults are given below.

<table>
<thead>
<tr>
<th>Cause of error</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Power LED does not illuminate.</td>
<td></td>
</tr>
<tr>
<td>For the USB modem: The USB cable is not connected.</td>
<td>Connect the USB cable.</td>
</tr>
<tr>
<td>For the RS232 modem: Power adapter is not connected to the modem.</td>
<td>Connect the power adapter and check.</td>
</tr>
<tr>
<td>Hardware error has occurred.</td>
<td>Replace the device.</td>
</tr>
<tr>
<td>The Power LED blinks during the parameterization of the transmitter.</td>
<td></td>
</tr>
<tr>
<td>No transmitter connected.</td>
<td>Check whether the transmitter is connected with the modem with correct polarities or whether the loop current is at least 3.5 mA.</td>
</tr>
<tr>
<td>The Comm LED does not illuminate.</td>
<td></td>
</tr>
<tr>
<td>For the USB modem: Modem is not detected by the PC.</td>
<td>Check the port settings in SIPROM T; Check the driver installation and reinstall SIPROM T if required.</td>
</tr>
<tr>
<td>For the RS232 modem</td>
<td></td>
</tr>
<tr>
<td>RS232 not connected with the PC.</td>
<td>Connect RS232 with the PC.</td>
</tr>
<tr>
<td>Modem is not detected by the PC.</td>
<td>Check the COM port settings in SIPROM T.</td>
</tr>
<tr>
<td>The Error LED illuminates during the parameterization of the transmitter.</td>
<td></td>
</tr>
<tr>
<td>Short circuit at the modem terminals for the transmitter.</td>
<td>Check the wiring of modem terminals.</td>
</tr>
<tr>
<td>The Error LED illuminates continuously.</td>
<td></td>
</tr>
<tr>
<td>Hardware error has occurred.</td>
<td>If the Error LED remains illuminated even after repeatedly switching the power supply of modem on and off, the device is defective and must be replaced.</td>
</tr>
</tbody>
</table>

7.2 Maintenance

The modem for SITRANS TH100/TH200 is maintenance-free.
7.2 Maintenance
Modem for SITRANS TH100 and TH200 including the SIPROM T parameterization software

### Technical data

#### Power supply (relevant only for the RS232 version)

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply of the power adapter (power adapter is included in the scope of delivery)</td>
<td>AC 90 ... 265 V, 50/60 Hz, max 6 W</td>
</tr>
</tbody>
</table>

#### USB port (relevant only for the USB version)

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB version</td>
<td>USB 1.1, compatible with USB 2.0</td>
</tr>
<tr>
<td>USB current</td>
<td>Standard, &lt; 100 mA</td>
</tr>
</tbody>
</table>

#### Power supply of the transmitter

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available power supply</td>
<td>Max. 18 mA</td>
</tr>
<tr>
<td>Available supply voltage</td>
<td>Max. 15 V (at 4 mA)</td>
</tr>
</tbody>
</table>

#### Ambient conditions

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range of ambient temperature</td>
<td>0 °C ... 50 °C (32 °F ... 122 °F)</td>
</tr>
<tr>
<td>Range of storage temperature</td>
<td>-20 °C ... +65 °C (-4 °F ... +149 °F)</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>5 % to 80 % at 25 °C (no condensation)</td>
</tr>
<tr>
<td>Electromagnetic compatibility</td>
<td>EN 61326-1</td>
</tr>
</tbody>
</table>

#### Construction

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Approx. 250 g</td>
</tr>
<tr>
<td>Dimensions (W x H x D)</td>
<td>Approx. 105 x 58 x 26 mm</td>
</tr>
<tr>
<td>Degree of protection</td>
<td>IP20</td>
</tr>
</tbody>
</table>
Certificates

You will find these certificates on the enclosed CD and on the Internet.

See also

Certificates (http://www.siemens.com/processinstrumentation/certificates)
Index

C
COM port, 17
Configuring, 28

E
Eliminating the error, 35

H
Hardware requirements, 11

I
Installation
  SIPROM T parameterization software, 11
  USB modem, 13
Internet link
  Catalog FI 01, 5
  Instructions and manuals, 5
  Product information, 5
  Siemens regional offices, 5

L
LED, 30
LEDs, 30
Limitation of use, 9

M
Menus, 31
More information, 5

O
Operating systems, 11
Operation
  SIPROM T parameterization software,

P
Parameterization, 29
Parameterization software, 11, 17, 22
  Operation, 31
Product information on the Internet, 5

R
RS232 modem
  Scope of delivery, 10

S
Scope of delivery
  RS232 modem, 10
  USB modem, 10
Siemens Regional Office, 5
SIPROM T
  Operation, 31
Software requirements, 11

U
Uninstall
  USB driver, 24
  USB modem, 24
  USB driver, 12, 14, 17
  Uninstall, 24
  USB modem
    Scope of delivery, 10
    Uninstall, 23